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Warnings & Safety
Precautions

The following precautions should be observed before
using the Investigator™ ProGest Protein Digestion Sta-
tion (ProGest) and any associated apparatus. Although
units and accessories should normally be used with non-
hazardous voltages, there are situations where hazardous
conditions may be present. This unit is intended for use
by qualified personnel who recognize shock hazards and
are familiar with the safety precautions required to avoid
possible injury. Read the Operator’s Manual carefully
before operating the ProGest.

Safety Warning

1. Maintain a well ventilated laboratory.

2. Avoid a wet work area. Always work with dry
hands while standing on a dry, insulated surface
capable of withstanding the voltage being used.
The work area should be dry before using the
unit while the power is on.

3. Plug the instrument into a grounded power
line. Ensure that the power outlet in the labora-
tory is properly grounded. Also inspect the
power line cord and accessory cables before each
use for any damage.
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4. Be aware that high voltages could be a shock
hazard. For greatest safety, do not touch the
cables or other accessories while power is
applied to these. Always switch off the power
before connecting or disconnecting the cables or
accessories.

5. Replace fuses with only the same type and rat-
ing. Using an incorrect fuse could result in a fire
hazard.

Safety & Operating Symbols

The following symbols appearing on the unit or in the
manual are defined as follows:

Warning—The symbol of the stop sign is used through-
out the manual to indicate potential dangers that might
result in personal injury or damage to property.

Caution—The symbol of the crossed out bomb is used
throughout the manual to indicate conditions that could
cause damage to the unit.

Note—This statement is used throughout the manual to
highlight important information about the system.

Installation

Warning—If there is any evidence that the ProGest unit
has been damaged in shipping, do not plug the unit into
the power line. Contact Genomic Solutions Technical
Service for advice.
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Power Requirements

The ProGest uses a three-prong power cord that includes
a ground wire. The unit must be connected to a properly
grounded power supply outlet to ensure proper operation.
If there is any doubt about the intended power supply
outlet, a qualified electrician should be contacted. Both
the ProGest and its accessories will be pre-set at the fac-
tory for the correct voltage for its destination. The volt-
age switch setting for the ProGest is internal and should
not be accessed except by Genomic Solutions personnel.

Warning—Failure to provide a well-grounded outlet
used by the ProGest could lead to a potential shock haz-
ard.

Specifications

General:

• Dimensions: 41cmW x 61cmD x 67.1cmH
(15.8”W x 24”D x 26.4”H)

• Weight: 54.8kg (121 lbs.)

Electrical:

• Mains input: 220-240V ac or 100-120V ac

• 50/60 Hz

• 150 VA max
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Environmental:

The ProGest is intended for safe operation under the fol-
lowing conditions:

• Indoor use

• Up to an altitude of 2000m

• Between the temperatures of 5° C and 40° C

• Maximum relative humidity of 80% for temperatures
up to 31° C, decreasing linearly to 50% relative humid-
ity at 40° C

• Where mains supply voltage fluctuations do not exceed
±10% of the nominal voltage

• Environment should be dust and vibration free.

Computer (not supplied):

• 2MB of internal disk storage

• Color monitor (minimum screen resolution
800x600)

• Windows®95/98 or Windows NT® 4.0 or later

• RS232 port (for cable connections to ProGest)

Instrument Maintenance

Clean the ProGest exterior, reagent area and reaction and
collection areas with a damp cloth.
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Warning—Be sure to power the instrument off and dis-
connect the power cord before cleaning the instrument.
DO NOT allow any liquid to enter the inside of the
power unit. This could damage the unit and present a
potential shock hazard.
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Letter of Conformity—CE

DECLARATION OF CONFORMITY

Manufacturer’s Name: Genomic Solutions Inc.
Manufacturer’s Address: Genomic Solutions Ltd.

Unit 3, Forge Close
Little End Road, Eaton Socon
St. Neots, Cambridgeshire
United Kingdom

Declares, that the product:
Product Description: Protein Digestion System
Model: Investigator ProGest

Conforms with the protection requirements of Council Directive 89/336/EEC,
relating to electromagnetic compatibility.

By application of the following standards:

BS EN 61326-1 : 1997 Electrical Equipment for Measurement
Control and Laboratory Use.

BS EN 60555-2 : 1995 Mains Harmonic.

Signature:

_______________________ _________________________
Andy Jakimcius John Parker
EVP, Operations Engineering Manager
Genomic Solutions Inc. Genomic Solutions Ltd.
United States United Kingdom
Date: 1 March, 1999
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1 Introduction

The Investigator™ ProGest Protein Digestion Station
(ProGest) is an automated instrument for the enzymatic
digestion of proteins contained in pieces of gel after elec-
trophoretic separation. The ProGest performs enzymatic
digestion on up to 96 samples simultaneously. It auto-
mates the following steps:

• Washing of the gel slices with various buffers

• Reduction of disulfide bonds at 60° C

• Alkylation of cystine residues with iodoaceta-
mide

• Removal of excess reagents

• Equilibration with digest buffer

• Addition of digestion enzyme (optional up to 4
enzymes)

• Incubation at 37° C for digestion

• Elution of peptides from the gel matrix
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System Components

The major components of the system are:

• Pipetting robot

• Dual syringe dilutor unit

• Work area with heatable reaction block, sol-
vents and reagent rack, collection rack

• Built-in Touchpad and Liquid Crystal Display,
single board computer, plus disk drive (3.5”
HD disks only) and operating software

• Protective cover
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System Software

The operating software for the Genomic Solutions
ProGest is stored permanently on a single chip FlashDisk
on the PC board within the controller.

Upgrades can be loaded (manually) by transferring files
from a 3.5” (1.44MB) floppy disk or by means of the
Method Editor. See “Upgrading Software” on page 96 for
information about upgrading software at the ProGest, or
“Loading Software” on page 54 for information about
downloading software from the Method Editor to the
ProGest. Future ProGest software upgrades will be avail-
able from the Genomic Solutions website.
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System Hardware

5
10

1 Transfer Tubing
2
3 Dilutor Unit for Syringes
4 Pipetting Robot Arm
5 Work Area
6 Keypad

8 Waste Bottles

10 Reaction Block

3

6

9

7

8

11

11 Reagent Rack

12

1

Dual Probes 9 Protective Cover

7 Dilutor Reservoir

12 Collection Rack

2
4

8
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1 Keypad 4 Screen Adjustment Knob
2 On/Off Switch 5 Connector for keyboard
3 3.5” Disk Drive

System Overview

The ProGest can be controlled:

• from the touchpad on the ProGest itself. Characters are
digitally displayed on a Liquid Crystal Display.

• from a computer by means of a serial port connection
from the RS485 interface on the ProGest using the
Method Editor software program.

The touchpad contains display and function information.
It allows the user to select from methods stored on the
ProGest itself, or on a 3.5” floppy disk, select the desired
sample locations on the 96-well plate and start, delay a
start, run, pause or abort the method.

1

2 3
4

5
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The ProGest can also be run by means of networking
through a cable connection from the ProGest to your PC.

PC Specifications for ProGest Method Editor software:

• Windows® 95/98 or Windows NT® 4.0 or later

• RS232 port (for cable connection to ProGest)

• 2 MB disk space

• Color Monitor (minimum screen resolution 600 x 800)

Using the Method Editor software program on your PC
allows for:

• convenient method transfer—instead of storing method
files on a floppy disk and transferring them manually to
the ProGest, they can be sent to the ProGest by means
of the Method Editor and stored on your PC’s hard
drive. Refer to “Method Transfer” on page 86 for more
information.

• remote supervision—the Method Editor software can
supervise a number of Genomic Solutions instruments
(such as ProGests and ProMS’s) simultaneously. The
status of each is shown in the network view of the edi-
tor. Refer to “Network Status” on page 82 for more
information.

• remote control—the Method Editor software allows the
user to start, stop, or pause a ProGest. You can also
select sample wells directly from the PC by means of
the Method Editor program. Refer to “Controlling
ProGest Remotely” on page 84 for more information.

General steps involved in the operation of the ProGest
are as follows:
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• Isolate the protein samples to be analyzed—
this step can be performed manually, or auto-
matically by the Flexys® Protein Picker

• Add the ProGest prepacked reagents or fill up
the reagent and solvent tubes

• Prime the syringes

• Load the reaction block with a red colored
Reaction plate containing the gel pieces

• Load the collection rack with the blue colored
Collection plate

• Select the protocol to be run

• Select the wells in the red Reaction plate that
contain gel pieces

• Close the cover

• Execute the program

Method

Protein Identification

Enzymatic digestion is a standard technique used as part
of the sample preparation process for a number of analyt-
ical techniques which can include peptide mapping by
LC (Liquid Chromatography) and CE (Capillary Electro-
phoresis), but most commonly by mass spectrometry by
either MALDI TOF or MS/MS. The profile of the peptide
fragments generated by trypsin digestion (the most com-
monly used enzyme), can be considered to be a finger-
print for each protein. The masses of each peptide
fragment from a protein ‘fingerprint’ can be accurately
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determined by mass spectrometry and these fragment
sizes can be used to search against a variety of databases
for a ‘match’. From this ‘match’ the identity of the pro-
tein may be determined.

Principle of Operation—ProGest

After the gel has been stained with silver, Coomassie
blue or fluorescent stains such as SYPRO® Ruby
(Molecular Probes, Oregon, USA), a gel sample no larger
than 2mm in diameter and up to 2mm in depth is excised,
using either the Flexys Protein Picker or manually using
a clean pipette tip or scalpel blade. It is not necessary to
mince the gel core into smaller pieces.

The gel pieces are placed in specially designed 96-well
microtiter plates (red colored) that are mounted on the
Reaction block within the ProGest. These Reaction plates
simply and effectively allow for the addition and removal
of reagents without the liquid handling portion of the
robot (Dual Probes—see diagram on page 4) coming into
contact with the sample at any stage and thereby prevent-
ing cross contamination from one sample to another. At
the bottom of each well in the 96-well microtiter plate are
two small holes. The holes are sufficiently small so that
the solution does not leak from the well. The solution is
only expelled when the outer probe forms a seal with the
film and nitrogen gas pushes the fluid through the small
holes into the blue colored Collection plate mounted on
the Collection rack. The microtiter plate well therefore
serves as a flow-through reactor and is the key element in
a series of reactions performed by the ProGest.
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Protein Digestion Methodology performed
by the ProGest (Default Method)

The gel pieces contain high concentrations of buffers and
detergents that are typically used in all standard separa-
tions performed by 1D and 2D electrophoresis. These
must be removed from the gel so that effective digestion
of protein samples can be performed with trypsin. This is
achieved by dehydrating the gel with several successive
washes with acetonitrile followed by rehydration with
bicarbonate buffer.

Natural proteins often contain disulfide bridges that
maintain the secondary structure of the protein and would
otherwise interfere with the digestion of the protein by
trypsin. The ProGest reduces these by incubating the gel
pieces with DTT at 60° C and alkylates the free sulfhy-
dryl groups with iodoacetamide. Excess reagents are
removed between each step by a series of dehydration
and rehydration steps as described above.

After reduction and alkylation, trypsin (stored in acidic
buffer to prevent autodigestion), is activated by the
ProGest by diluting the enzyme with ammonium bicar-
bonate buffer pH 8. Activated enzyme in ammonium
bicarbonate buffer is added to each gel sample and is
incubated at 37° C for approximately 1.5 hours depend-
ing on the methodology selected. Each well in the red
colored Reaction plate receives a further small aliquot of
water to replace any solution lost through evaporation
and is incubated at 37° C for a further 1.5 hours.

When the trypsin is added, the Reaction Block containing
the red colored Reaction plate is moved from above the
waste position to the collection position. Here the result-
ing peptides are extracted from the gel by a series of
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washes with ammonium bicarbonate buffer, formic acid
and acetonitrile, an acidic, basic and organic elution.

Typically, the peptides are immediately dried by freeze
drying or in a vacuum centrifuge. The peptide is resus-
pended in an appropriate buffer ready for analysis by
mass spectrometry, LC or CE or Edman degradation. For
analysis by MALDI TOF mass spectrometry using the
Investigator ProMS system, the peptides can be taken up
into 100µl of 10% formic acid and automatically con-
centrated and desalted using micro reverse phase sample
preparation techniques and spotted onto the MALDI tar-
get in matrix. If spotting by hand, the peptides can be
taken up into a very small volume (10µl) of formic acid,
then concentrated and desalted using micro reverse phase
sample preparation techniques and spotted onto the
MALDI target in matrix.

General Safety Procedures

• The instrument must be operated by trained personnel
only. It is important to know and understand safety reg-
ulations regarding the instrument and the contents of
the operator’s manual.

• Chemicals must be handled with care. Please observe
the current national safety regulations regarding the use
and disposal of the following chemicals:

• Acetonitrile (ACN)

• Ammonium Bicarbonate (ABC)

• Formic Acid (HCOOH)

• Dithiothreitol (DTT)

• Iodoacetamide (IAM)
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• Enzymes

• Wear safety glasses, gloves and a lab coat during
reagent preparation and instrument set-up. If accidental
spillage occurs, carefully clean up the spillage taking
into account the nature of the spilled liquid and the nec-
essary precautions.

• Prepare reagents in a fume hood.

• During operation the instrument generates vapors
which pose a health hazard. The ProGest should only
be operated with the protective cover closed in a well
ventilated location. Please consult your organization’s
safety regulations as to whether this instrument should
be operated in a specially designated area or fume
hood.

• Please make sure that nothing interferes with the move-
ment of the instrument parts. Nothing should be placed
in or around the field of movement of either the hori-
zontal or vertical arm of the robot. You must not oper-
ate the robot without closing the protective cover as
the moving arm and probe can lead to injuries.

• Voltages present inside the instrument are potentially
dangerous. If there is a problem with the instrument,
make sure to switch the unit off. The power cord
should be removed until qualified service personnel
have repaired the unit. This is to prevent anyone from
inadvertently using the instrument, thus causing possi-
ble harm to themselves or damage to the instrument
itself.
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About the User’s Manual

This chapter provides system component information,
safety instructions, a system overview and a description
of the principles involved in the digestion procedure uti-
lized in the ProGest station.

There are five more chapters and an appendix in the man-
ual:

“Chapter 2 Operation” describes how to operate the
ProGest during standard operation.

“Chapter 3 Protocols” lists step by step each of the proto-
cols provided with the ProGest.

“Chapter 4 Method Editor” describes the Investigator™
ProGest Method Editor software provided with the
ProGest which enables the user to create or edit digestion
protocols, network several ProGest instruments, and run
the system(s) by means of an attached PC.

“Chapter 5 Maintenance” describes some routine main-
tenance procedures along with cleaning and storage
information for the system.

“Chapter 6 Troubleshooting” provides some basic trou-
bleshooting tips with possible causes and solutions.

“Appendix A: Trypsin Digestion Kit” contains instruc-
tions for preparing the ProGest Trypsin Digestion Kit
recommended for use with the Investigator ProGest Pro-
tein Digestion Station.
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“Appendix B: ProGest Validation Kit” describes the kit
available for use in the set up and validation of the instru-
ment.
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2 Operation

This chapter describes the use of the Genomic Solutions
ProGest during operation. You will learn how to:

• Turn the system on and off

• Prepare reagents

• Prepare the system for operation

• Load the work area

• Start a run

• Stop, interrupt or abort a run

Preparing the system

Empty waste bottle

Note: The chemicals in the waste bottles are hazardous
material which must be disposed of properly. Ask your
safety officer and follow the regulations of your institu-
tion.

1. Empty waste bottles (1) into appropriate reser-
voir or container.
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2. Fill up the dilutor reservoir (2) with 18 MOhm-
water which has been filtered through a 0.45µm
filter and degassed.

Preparing reagents

Before each run, you will need to prepare solvents as
fresh solutions. It is recommended that the ProGest be
used with ProGest Trypsin Digestion kit,
Cat. No. 70-0210. Refer to “Appendix A: Trypsin Diges-
tion Kit” on page 113 for reagent preparation instruc-
tions. For safety reasons, be sure to wear safety glasses,
gloves and a protective suit or coat when handling sol-
vents.

The reagents and solvents listed below are used in the
protocols provided with the ProGest.

• Solvents:

Dilutor

Waste bottles

Reservoir1

2
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• Acetonitrile (ACN) 100%—used for washing
and shrinking the gel pieces. Note: This solu-
tions should be stored in glass.

• Ammonium Bicarbonate (ABC) 50mM—used
for buffering the reactions.

• Ammonium Bicarbonate (ABC) 25mM—used
for buffering the reactions.

• Reagents:

• 10mM Dithiothreitol (DTT) in either 25mM
or 50mM ABC—used for reducing the disul-
fide bridges in protein.

• 100mM Iodoacetamide (IAM) in 50mM
ABC—used for alkylating the free Cys-SH
groups.

• Enzyme:

• Trypsin (20µg)—used for enzymatically frag-
menting the proteins.

Loading the work area

The ProGest has a number of containers for the liquids
that are used during the digestion process.
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The vial locations are assigned specific letters which
relate to their location on the ProGest reagent area. For
reagent placement used in the protocols provided with
the ProGest, refer to “Appendix A: Trypsin Digestion
Kit” on page 113.

Solvent A: This position is used for the Acetonitrile as it
will hold a 100ml glass bottle.

Solvents B through F: These positions are used for other
solvents, such as They will hold 30ml plastic vials.
Note: Be sure to check which positions are selected for
your protocol by checking Vial Contents Names under
the Edit menu in the Method Editor software.

Reagent A: (DTT). This will hold a 10 or 15ml plastic
vial.

Reagent B: (IAM). This will hold a 10 or 15ml plastic
vial.

Enzyme A: These positions can be used for enzyme solu-
tions. They will each hold a 0.5ml microfuge tube.

B C D E F

A

Rgt BRgt AEnzyme
A

Enzyme
B

Enzyme
C

Enzyme
D

Solvent

Solvent Solvent Solvent Solvent Solvent
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Enzyme B: These positions can be used for enzyme solu-
tions. They will each hold a 2ml microfuge tube.

Enzyme C: This position can be used for enzyme solu-
tions. This will hold a 10ml plastic tube.

Enzyme D: This position can be used for enzyme solu-
tions. This will hold a 10ml plastic tube.

If you are using the one of supplied protocols, be sure to
check the proper placement of the reagents using the
Method Editor. See “Appendix A: Trypsin Digestion Kit”
on page 113.

Isolating protein samples

The proteins to be analyzed are usually separated by 1D
or 2D polyacrylamide gel electrophoresis (PAGE). After
staining, the protein features can be excised from the gel
using a clean pipette tip cut so that the internal diameter
of the tip gives a gel plug of up to 2mm in diameter or by
using a clean scalpel blade.

This process can be readily automated using the Flexys™
Protein Picker in which protein features of interest are
cored and placed into the red colored Reaction plate.
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Loading the reaction wells

To load the reaction plate containing the gel pieces:

1. Remove the Reaction Plate Cover by removing
the four corner screws that hold the Reaction
Plate Cover onto the Reaction Block.

2. Place the red colored Reaction plate containing
the samples into the Reaction Block with the A1
well located at the back on the left.

3. Place the plastic film on top of the sample tray
using gloves to avoid contamination.

Reaction Plate Cover

Reaction Block

Alignment block
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4. Replace the Reaction Plate Cover with the four
corner screws, finger tighten by quarter turns on
the diagonal nuts to ensure an even seal. The
plate has 96 O-rings on the underside which seal
the film to the red plate.These screws need to be
tight to ensure there is a seal made between the
film and the red tray. However, do not over-
tighten as that may cause the reaction wells to
fail to seal completely.

If loading the reaction wells manually:

1. Remove the Reaction Plate Cover by removing
the four corner screws holding the Reaction Plate
Cover onto the Reaction Block.

2. Load the red colored Reaction plate before plac-
ing in the Reaction Block in the following order:

• Place a blank control at the beginning of the
sample run (i.e. a reaction well with gel matrix
but no protein sample). Blank controls are use-
ful on high sensitive runs to identify enzyme
peptides derived from autodigestion.
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• Place your sample gels into the next available
spaces in the red colored plate making sure to
note the identity of all samples and their posi-
tion on the reaction tray.

• Continue until all sample gels have been
placed in the red colored Reaction plate.

• Place a blank control at the end of the series of
samples.

3. When all samples have been put in the red col-
ored Reaction plate, place the Reaction plate into
the Reaction Block, place the plastic film onto
the reaction plate and replace the cover.

4. Secure the Reaction Plate Cover using the four
mounting screws at the corners as stated previ-
ously. Note: Do not overtighten as that may
cause the reaction wells to fail to seal completely.

Preparing the Reaction Plate

Once the reaction plate with the plastic film cover has
been placed on the reaction block and secured using the
four corner screws, holes need to be pierced into each of
the 96 wells prior to running the instrument.

A small metal rod is included with the system. Using the
small tool, gently pierce the plastic covering each of the
wells as shown, pushing the tool down as far as it will go.
It is recommended that you keep the tool clean and do not
handle the tip. Store it in a clean tube to keep the tip
sharp. (This is important as it ensures the hole gives a
good seal to the probes.)
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Removing the Reaction Block

For easier operation, you can remove the entire Reaction
Block from the sliding frame, but it is not necessary:

1. Move the Reaction Block to the left end of the
sliding frame.

2. Lift the left side until the alignment pins are visi-
ble.

3. Move the block over the rightmost position and
lift the right side. Be sure not to damage the four
alignment pins at the corners.

4. Replace the Reaction Block in the work area by
reversing this procedure. Make sure the block
slides freely on the sliding frame. The Reaction
Block should be positioned centrally on the slid-
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ing frame. It is moved to the correct position by
the needle at the beginning of the run.

Load the collection rack

Once the samples have been placed in the Reaction Block
and covered, a blue colored Collection plate must be
placed onto the collection block.

Switching the system on

During operation of the ProGest, organic vapors are gen-
erated. For safety reasons the following conditions must
be observed during the system operation:

• operate only with protective cover closed

• make sure nothing hinders the movement of
the instrument arm and probes

1. Verify that the power cord is plugged in.

Collection Plate
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2. Close the protective cover making sure not to
catch the cable connecting the heater block.

3. Adjust the nitrogen pressure to 15psi (1bar).
Once 15psi is acheived, allow 15 minutes for the
regulator valve to stabilize.

4. Switch the system ON with the On/Off switch at
the front of the instrument. The system will boot
up and then the main menu will appear.

Settings

The instrument automatically saves the following set-
tings from the previous run:

• Method

• Plate Configuration

• Start Delay

To perform a run according to the previous settings, no
changes to the settings need to be made. For a first time
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user or to change the existing settings, follow the instruc-
tions in Method Selection.

Method Selection

The first step is to load a digestion method, if none has
been previously selected.

1. Press Method on the keypad. A list of available
methods will appear.

2. Select the desired digestion method. Note: The
protocols provided are listed step by step in
“Chapter 3 Protocols” and how to edit or create
protocols is covered in “Chapter 4 Method Edi-
tor”. Note: Machine Test is a maintenance func-
tion and is not a digestion method.
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Plate Configuration

Once the digestion method has been selected, the next
step is to set up the plate configuration (which wells of
the plate are to be processed). Select Plate Configura-
tion from the keypad.

1. A screen will appear with a schematic of a Reac-
tion plate divided into four parts. Quadrants
selected for processing are shown white, unse-
lected quadrants in black.

2. If particular positions on the 96 well plate are
desired, select the desired quadrant by touching
the screen in that quadrant. Note that wells are
processed in pairs due to the twin probe configu-
ration. A window will appear showing the sam-
ple positions in that quadrant.

3. Touch the desired positions to select them. If
selected they will appear white. The user may
choose to Select All, which changes the color of
all the wells in that quadrant to white.
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4. The user may select to Clear All, or clear each
two sample position by touching the appropriate
sample block. The sample pair will go dark, indi-
cating that it is no longer selected.

5. When you are finished selecting the appropriate
sample positions, select Done to return to the
previous window. It is not necessary to access all
quadrants. The previous settings for a quadrant
will be maintained or you may repeat steps 2
through 4 to select wells in another quadrant.

6. When you are finished selecting the appropriate
sample positions, select Done to return to the
previous window. The window will appear with
check marks in the quadrants that has been indi-
vidually altered. The quadrants will appear as:

• White—all wells selected

• Black—no wells selected

• Gray—some wells selected
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7. When you are finished, select Done to return to
the Main menu.

Priming

Before starting the run, it is necessary to prime the dilu-
tor. This fills the syringe and tubing from the reservoir
with fluid and purges air.

1. Select Plate Configuration from the keypad.

2. Select Setup from the keypad.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Chapter 2: Operation

30 3/28/01 Investigator ProGest

3. Press Prime Dilutor to start priming. The probes
will be placed over the rinse port and the
syringes will fill and empty.

4. Check for bubbles in the syringes or tubing. Con-
tinue priming until no bubbles are present.

5. Once pressed, the Prime Dilutor key will change
to Stop Dilutor. Press Stop Dilutor to stop the
priming. The instrument will complete its prime
sequence and return to the default position.

6. Select Done to exit the window and return to the
Main menu.

Start Digestor

1. Press Start Digester to execute the digestion
program. A window will appear asking the user
if they would like to delay the start of the run.
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2. The start of the run can be delayed up to 23 hours
and 50 minutes. This will enable the user to time
the digestion to end whenever desired.

3. Select the delay time in hours and minutes, if
desired, then press Start. You may also select to
Cancel the run from this screen. This will take
you back to the Main menu.

4. During the run various messages will be dis-
played describing the status of the system at that
time, an approximate estimation of completion
time and/or any error conditions that may arise.

5. When the run is finished, the screen will indicate
that the program is finished.

Interrupting / Aborting the program

The program can be stopped or interrupted at any time
during its operation by the following steps:

1. Select Pause Digestion to temporarily stop the
program. The system will finish the current oper-
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ation and then stop. A window will appear asking
for instructions.

2. Press Continue to continue the run or Cancel to
abort the run. If you select Cancel, the pipetting
arm and dilutor will reset and a window will
appear informing you that the run has been can-
celled.

3. Select Return to Main menu. The system will
go back to the Main menu.
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Handling the eluted peptides

Once the digestion program is finished, the eluted pro-
teins may be removed for further analysis.

1. Slide the Reaction Block to the left.

2. Remove the blue Collection plate containing the
eluted peptides and label it as needed for future
identification.

3. To prepare the peptides for further analysis, dry
the solution by freeze drying or using a vacuum
centrifuge.

Set Up

This window allows the user access to some of the set up
and troubleshooting functions available in the ProGest
such as priming, loading a syringe, upgrading software,
selecting addresses for networking, nitrogen and heater
check. Except for priming, these functions would not be
used routinely during operation, only during network
setup, maintenance or troubleshooting. To access this
screen:

1. Power up ProGest instrument if not already run-
ning.

2. Select Plate Configuration from the keypad.

3. Select Setup from the keypad. The Engineering
Options window will appear.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Chapter 2: Operation

34 3/28/01 Investigator ProGest

The Engineering Options are covered in “Chapter 5
Maintenance”. Refer to “Priming the dilutor” on page 96,
“Upgrading Software” on page 96 and “Changing the
dilutor syringe” on page 91 for more information about
these selections.

The Autosampler Control allows the user access to check
the nitrogen valve and heater control. Refer to “Check
Nitrogen Valve” on page 97 and “Check Heater” on
page 98 for more information.

Other options under Autosampler control refer to robotic
arm movements and should be accessed by service per-
sonnel only due to the possibility of damage to the
probes.

Network Address allows the user to scroll through the
network addresses to select the correct address for net-
working multiple instruments on the ProGest. Refer to
“Network Address” on page 99 for more information.
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Switching the system off

The instrument stops operation after execution of the pro-
gram and returns to the stand-by mode. The program fin-
ished message will be displayed. If you do not intend to
use the instrument for some time you may want to switch
it off entirely.

1. Switch off the system with the On/Off switch.

2. Remove the reaction and collection racks, dis-
pose of reagents.

3. Empty waste bottle and dispose of solvents
according to institution or national standards.

4. Clean the instrument as described in the mainte-
nance section.

Emergency STOP

In case of an emergency, press the On/Off switch located
at the front of the instrument to power the system off.
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3 Protocols

Listed in this chapter is a step by step description of the
default digestion methods provided with the ProGest and
also the Silver Destain Method.

Short Trypsin Digestion (Default1.met)

Step
Number

Description

1 Moving rack to run position
Start: X 2100, Y 925, Z 110
Stop: X 447, Y 925

2 Moving rack to run position
Start: X 0, Y 925, Z 110
Stop: X 93, Y 925

3 Moving rack to run position
Start: X 300 Y 925 Z 80
Stop: X 419 Y 925

4 Pierce Sheet
Source: Reservoir Vol: 0µl
Hold Time: 0 seconds

5 Turn off Heaters Heater: OFF
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6 Initial Rinse Inside: 2000µl Outside: 3000µl

7 Washing with Bicarbonate
Source: 25mM Bicarbonate, Vol: 100µl
Hold Time: 0 seconds

8 Soak in ABC
Delay: 20 minutes 0 seconds

9 Purging ABC
Source: Acetonitrile Vol: 0µl
Hold Time: 0 seconds

10 Washing with CH3CN
Source: Acetonitrile Vol: 50µl

11 Start Timer Starting Timer: 1
Time: 15 minutes 0 seconds

12 Neutralizing with ABC
Source: 50mM Bicarbonate, Vol: 50µl

13 Reaction Time
Waiting for Timer: 1

14 Shrinking gel
Source: Acetonitrile Vol: 100µl
Hold Time: 10 minutes 0 seconds

15 Set Heaters to High
Heater: HIGH

16 Reduction with DTT
Source: DTT Vol: 30µl
Hold Time: 10 minutes 0 seconds

17 Turn off Heaters Heater: OFF

Step
Number

Description
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18 Reduction (cooling)
Delay: 20 minutes 0 seconds

19 Alkylation
Source: Iodoacetamide Vol: 30µl
Hold Time: 15 minutes 0 seconds

20 Washing with ABC
Source: 50mM Bicarbonate Vol: 40µl
Hold Time: 10 minutes 0 seconds

21 Washing with CH3CN
Source: Acetonitrile Vol: 50µl
Hold Time: 15 minutes 0 seconds

22 Shrinking with CH3CN
Source: Acetonitrile Vol: 50µl
Hold Time: 15 minutes 0 seconds

23 Purge wells
Source: Acetonitrile Vol: 0µl
Hold Time: 10 minutes 0 seconds

24 Prepare enzyme
Source: 25mM Bicarbonate Vol: 950µl
Destination: Trypsin Vol: 900µl

25 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

26 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

Step
Number

Description
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27 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

28 Adding Enzyme to samples
Source: Trypsin Vol: 15µl
Hold time: 10 minutes 0 seconds

29 Moving rack for extraction
Start: X 400, Y 925, Z 80
Stop: X 1642, Y 925

30 Moving rack for extraction
Start: X 1610, Y 925, Z 80
Stop: X 1642, Y 925

31 Set Heaters to 37° C. Heater: LOW

32 Digestion—first stage
Delay: 1 hour 30 minutes 0 seconds

33 Rinse needles: Inside: 1000µl Outside: 1000µl

34 Adding water to gel
Source: Water Vol: 10µl

35 Digestion—second stage
Delay: 2 hour 0 minutes 0 seconds

36 Rinse needles: Inside: 2000µl Outside: 2000µl

37 Adding ABC
Source: 25mM Bicarbonate Vol: 10µl

38 Extracting peptides
Delay: 10 minutes 0 seconds

Step
Number

Description
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39 Adding CH3CN for extraction

Source: Acetonitrile Vol: 20µl

40 Incubation with CH3CN

Delay: 10 minutes 0 seconds

41 Extracting with Formic Acid
Source: 10% Formic Acid Vol: 20µl
Hold Time: 10 minutes 0 seconds

42 Start Timer Starting Timer: 1
Time: 15 minutes 0 seconds

43 Adding CH3CN for extraction
Source: Acetonitrile Vol: 20µl

44 Extraction with CH3CN
Waiting for timer: 1

45 Shrinking with CH3CN

Source: Acetonitrile Vol: 30µl
Hold Time: 15 minutes 0 seconds

46 Purge wells
Source: Acetonitrile Vol: 0µl
Hold Time: 10 minutes 0 seconds

47 Rinse Inside: 2000µl Outside: 2000µl

48 Turn off heaters Heater: OFF

Step
Number

Description
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Ag Destain Trypsin Digestion (Destain.met)

Step
Number

Description

1 Moving rack to run position
Start: X 2100, Y 925, Z 110
Stop: X 447, Y 925

2 Moving rack to run position
Start: X 0, Y 925, Z 110
Stop: X 93, Y 925

3 Moving rack to run position
Start: X 300 Y 925 Z 80
Stop: X 419 Y 925

4 Pierce Sheet
Source: Reservoir Vol: 0µl
Hold Time: 0 seconds

5 Turn off Heaters Heater: OFF

6 Initial Rinse Inside: 2000µl Outside: 3000µl

7 Destain
Source: Destain, Vol: 50µl
Hold Time: 15 minutes 0 seconds

8 Wash with Bicarbonate
Source: 25mM Bicarbonate Vol: 100µl
Hold Time: 10 minutes 0 seconds

9 Wash with Bicarbonate
Source: 25mM Bicarbonate Vol: 100µl
Hold Time: 10 minutes 0 seconds
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10 Wash with Bicarbonate
Source: 25mM Bicarbonate Vol: 100µl
Hold Time: 10 minutes 0 seconds

11 Purging ABC
Source: Acetonitrile Vol: 0µl
Hold Time: 0 seconds

12 Washing with CH3CN
Source: Acetonitrile Vol: 50µl
Hold Time: 0 seconds

13 Start Timer Starting Timer: 1
Time: 15 minutes 0 seconds

14 Neutralizing with ABC
Source: 50mM Bicarbonate, Vol: 50µl

15 Reaction Time
Waiting for Timer: 1

16 Shrinking gel
Source: Acetonitrile Vol: 100µl
Hold Time: 10 minutes 0 seconds

17 Set Heaters to High
Heater: HIGH

18 Reduction with DTT
Source: DTT Vol: 30µl
Hold Time: 10 minutes 0 seconds

19 Turn off Heaters Heater: OFF

Step
Number

Description
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20 Reduction (cooling)
Delay: 20 minutes 0 seconds

21 Alkylation
Source: Iodoacetamide Vol: 30µl
Hold Time: 15 minutes 0 seconds

22 Washing with ABC
Source: 50mM Bicarbonate Vol: 40µl
Hold Time: 10 minutes 0 seconds

23 Washing with CH3CN

Source: Acetonitrile Vol: 50µl
Hold Time: 15 minutes 0 seconds

24 Shrinking with CH3CN

Source: Acetonitrile Vol: 50µl
Hold Time: 15 minutes 0 seconds

25 Purge wells
Source: Acetonitrile Vol: 0µl
Hold Time: 10 minutes 0 seconds

26 Prepare enzyme
Source: 25mM Bicarbonate Vol: 950µl
Destination: Trypsin Vol: 900µl

27 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

28 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

Step
Number

Description
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29 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

30 Adding Enzyme to samples
Source: Trypsin Vol: 15µl
Hold time: 10 minutes 0 seconds

31 Moving rack for extraction
Start: X 400, Y 925, Z 80
Stop: X 1642, Y 925

32 Moving rack for extraction
Start: X 1610, Y 925, Z 80
Stop: X 1642, Y 925

33 Set Heaters to 37° C. Heater: LOW

34 Digestion—first stage
Delay: 1 hour 30 minutes 0 seconds

35 Rinse needles: Inside: 1000µl Outside: 1000µl

36 Adding water to gel
Source: Water Vol: 10µl

37 Digestion—second stage
Delay: 6 hour 0 minutes 0 seconds

38 Rinse needles: Inside: 2000µl Outside: 2000µl

39 Adding ABC
Source: 25mM Bicarbonate Vol: 10µl

40 Extracting peptides
Delay: 10 minutes 0 seconds

Step
Number

Description

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Chapter 3: Protocols

46 3/28/01 Investigator ProGest

41 Adding CH3CN for extraction
Source: Acetonitrile Vol: 20µl

42 Incubation with CH3CN
Delay: 10 minutes 0 seconds

43 Extracting with Formic Acid
Source: 10% Formic Acid Vol: 20µl
Hold Time: 10 minutes 0 seconds

44 Start Timer Starting Timer: 1
Time: 15 minutes 0 seconds

45 Adding CH3CN for extraction

Source: Acetonitrile Vol: 20µl

46 Extraction with CH3CN

Waiting for timer: 1

47 Shrinking with CH3CN

Source: Acetonitrile Vol: 30µl
Hold Time: 15 minutes 0 seconds

48 Purge wells
Source: Acetonitrile Vol: 0µl
Hold Time: 10 minutes 0 seconds

49 Rinse Inside: 2000µl Outside: 2000µl

50 Turn off heaters Heater: OFF

Step
Number

Description

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Chapter 3: Protocols

Investigator ProGest 3/28/01 47

Long Trypsin Digestion (Default2.met)

Step
Number

Description

1 Moving rack to run position
Start: X 2100, Y 925, Z 110
Stop: X 447, Y 925

2 Moving rack to run position
Start: X 0, Y 925, Z 110
Stop: X 93, Y 925

3 Moving rack to run position
Start: X 300 Y 925 Z 80
Stop: X 419 Y 925

4 Pierce Sheet
Source: Reservoir Vol: 0µl
Hold Time: 0 seconds

5 Turn off Heaters Heater: OFF

6 Initial Rinse Inside: 2000µl Outside: 3000µl

7 Washing with Bicarbonate
Source: 25mM Bicarbonate, Vol: 100µl
Hold Time: 0 seconds

8 Soak in ABC
Delay: 20 minutes 0 seconds

9 Purging ABC
Source: Acetonitrile Vol: 0µl
Hold Time: 0 seconds

10 Washing with CH3CN
Source: Acetonitrile Vol: 50µl
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11 Start Timer Starting Timer: 1
Time: 15 minutes 0 seconds

12 Neutralizing with ABC
Source: 50mM Bicarbonate, Vol: 50µl

13 Reaction Time
Waiting for Timer: 1

14 Shrinking gel
Source: Acetonitrile Vol: 100µl
Hold Time: 10 minutes 0 seconds

15 Set Heaters to High
Heater: HIGH

16 Reduction with DTT
Source: DTT Vol: 30µl
Hold Time: 10 minutes 0 seconds

17 Turn off Heaters Heater: OFF

18 Reduction (cooling)
Delay: 20 minutes 0 seconds

19 Alkylation
Source: Iodoacetamide Vol: 30µl
Hold Time: 15 minutes 0 seconds

20 Washing with ABC
Source: 50mM Bicarbonate Vol: 40µl
Hold Time: 10 minutes 0 seconds

21 Washing with CH3CN
Source: Acetonitrile Vol: 50µl
Hold Time: 15 minutes 0 seconds

Step
Number

Description
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22 Shrinking with CH3CN

Source: Acetonitrile Vol: 50µl
Hold Time: 15 minutes 0 seconds

23 Purge wells
Source: Acetonitrile Vol: 0µl
Hold Time: 10 minutes 0 seconds

24 Prepare enzyme
Source: 25mM Bicarbonate Vol: 950µl
Destination: Trypsin Vol: 900µl

25 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

26 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

27 Mixing enzyme
Source: Trypsin Vol: 600µl
Destination: Trypsin Vol: 600µl

28 Adding Enzyme to samples
Source: Trypsin Vol: 15µl
Hold time: 10 minutes 0 seconds

29 Moving rack for extraction
Start: X 400, Y 925, Z 80
Stop: X 1642, Y 925

30 Moving rack for extraction
Start: X 1610, Y 925, Z 80
Stop: X 1642, Y 925

Step
Number

Description
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31 Set Heaters to 37° C. Heater: LOW

32 Digestion—first stage
Delay: 1 hour 30 minutes 0 seconds

33 Rinse needles: Inside: 1000µl Outside: 1000µl

34 Adding water to gel
Source: Water Vol: 10µl

35 Digestion—second stage
Delay: 6 hour 0 minutes 0 seconds

36 Rinse needles: Inside: 2000µl Outside: 2000µl

37 Adding ABC
Source: 25mM Bicarbonate Vol: 10µl

38 Extracting peptides
Delay: 10 minutes 0 seconds

39 Adding CH3CN for extraction
Source: Acetonitrile Vol: 20µl

40 Incubation with CH3CN
Delay: 10 minutes 0 seconds

41 Extracting with Formic Acid
Source: 10% Formic Acid Vol: 20µl
Hold Time: 10 minutes 0 seconds

42 Start Timer Starting Timer: 1
Time: 15 minutes 0 seconds

43 Adding CH3CN for extraction

Source: Acetonitrile Vol: 20µl

Step
Number

Description
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44 Extraction with CH3CN

Waiting for timer: 1

45 Shrinking with CH3CN

Source: Acetonitrile Vol: 30µl
Hold Time: 15 minutes 0 seconds

46 Purge wells
Source: Acetonitrile Vol: 0µl
Hold Time: 10 minutes 0 seconds

47 Rinse Inside: 2000µl Outside: 2000µl

48 Turn off heaters Heater: OFF

Step
Number

Description
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4 Method Editor

This chapter will take you through all of the functions
and capabilities of the Investigator™ ProGest Method
Editor (Method Editor) software. In it you will learn how
to:

• create new protocols

• edit protocols

• network systems

• setup and run methods by means of a PC

Method Editor Overview

The Method Editor enables you to create and edit meth-
ods for the ProGest. The Method Editor also has the abil-
ity to control several ProGest and ProMS instruments,
connected by cable to your PC. This allows ease of
method transfer by allowing you to transfer methods cre-
ated on your PC directly to the ProGest. It also allows
remote control (start, stop, sample selection) of the
ProGest instrument. In addition, the Method Editor lets
you view all systems networked to your PC by means of
the main Method Editor screen which shows a set of pan-
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els, one for each device on the network. Each panel con-
tains a summary of the type of instrument and its current
status. You are able to control each instrument by click-
ing on its panel in the network view.

Loading Software

1. Download the Method Editor software from the
Genomic Solutions website directly into your com-
puter.

2. Follow the prompts in the installation program.

3. After installation or when you restart Windows™,
the Method Editor will be available via the Start
menu. If you are not familiar with Windows, refer
to the Windows Help for guidance.

4. Open the program by selecting and double-clicking
on the icon. The Method Editor window appears.

Method Editor Window

The main window of the Method Editor is divided into
four sections:
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• The Menu and Tool Bar—allows access to menus for
loading and saving methods, printing methods and
accessing other parameters.

• The Step List—shows a list of all the steps in the
method. You can select a step by clicking the left
mouse button on it. At the bottom of the step window
are two buttons controlling the simulator. These allow
the user to view the ProGest’s movements prior to actu-
ally running the protocol.

• The Step Properties—once a step has been selected, the
step parameters will appear in this section. Depending
upon the step, there can be several screens of parame-
ters. You may adjust any of the step’s parameters and
the method is updated automatically but not saved. To
save any changes, select the Save icon on the toolbar or
select Save as from the File menu.

Step List

Step Properties

Network Status

Menu & Tool Bar
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• The Network Status—if you are using networking this
part of the screen will show all of the Genomic Solu-
tion devices connected to your PC, the instrument type
and its status.

Menu Items and Tool Bar

Listed below is a description of each of the software
functions available in the menu and on the tool bar.

File

The following functions are found under the File menu in
the Method Editor software.

New

This command allows the user to create a new protocol
document by selecting steps, adding or deleting steps,
and also to name and save the resulting protocol method.

Select New from the File menu. A window will appear
that allows the user to select which type of method to cre-
ate.
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1. Select ProGest. The Method Editor window
remains open.

2. To create a protocol, select Append Step from the
Edit menu. The New Method Step window appears.

3. Select the appropriate step from the drop-down
menu list. Select OK.

4. The step will appear in the left half of the Method
Editor window as Step 1. Enter the required infor-
mation for the selected step. Refer to “List of
Steps” on page 65 for information about each step
option.

5. Continue appending steps as desired. Note: You
may also insert steps or delete steps under the Edit
menu. Insert step will insert a new step at the
selected or highlighted step. Delete step will delete
the selected or highlighted step. Refer to “Insert
Step” and “Delete Step” on page 61 for more infor-
mation.

6. When the protocol is complete, you may select to
name it by selecting Set Method Title from the File
menu; or save it by selecting Save As from the File
menu.
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Open

This command allows the user to open an existing proto-
col from the protocol directory provided with the
ProGest.

1. Select Open from the File menu. The Open Editor
window will appear.

2. Select (highlight) the desired protocol and select
Open to bring the protocol into the ProGest Diges-
tion Method Editor window.

3. The protocol will appear in the left-hand side of the
window where it can be edited or amended as
desired.

Save

This command allows the user to select a directory and
filename in which to save the opened protocol after mak-
ing changes to it.
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1. Select Save from the File menu. The Save As win-
dow appears in which you can name a directory and
file in which to save the protocol as a digestion
method (.met).

Save As

This command allows the user to select a directory and
filename in which to rename the opened protocol or save
an opened protocol not previously saved.

1. Select Save As from the File menu. The Save As
window appears in which you can name a directory
and file in which to save the protocol as a digestion
method (.met).

Set Method Title

This command allows the user to set or give a descriptive
title to a method.

1. Select Set Method Title from the File menu. The
Method Title window appears.

2. Type in the desired description title of the method
and select OK when finished. The title will appear
in the title bar of the opened window of the Method
Editor (in parenthesis) next to the file name and
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will be printed along with the file name if a proto-
col is printed. Note: The Method Title is what
will appear on the ProGest method list. It is rec-
ommended that you give each method a differ-
ent title so that you will be able to distinguish
them once they are loaded onto the ProGest.

Print

This command allows the user to print a copy of the
opened protocol.

1. Choose Print from the File menu. The Print win-
dow appears in which you can select your printer
information.

2. Select OK to print the protocol.

Print Preview

This function allows the user to view the layout of the
printed image prior to actually printing it.

1. Choose Print Preview from the File menu.

2. A window will appear showing the print layout
prior to printing.

Print Setup

This function allows the user to setup the printer layout
according to their own specifications.
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1. Choose Print Setup from the File menu. The Print
Setup window appears.

2. Choose the appropriate settings.

3. Select OK when finished.

Edit

This command allows the user access to editing functions
such as insert step, delete step, append step and edit vial
contents names.

Delete Step

This command allows the user to delete a selected step in
the opened protocol.

1. Select Delete Step from the Edit menu. Note: This
step will only be operable if a step is selected (high-
lighted) in an opened protocol in the Method Editor
window.

2. A warning message will ask the user if they are sure
they want to delete this step. Click Yes to delete the
step.
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Insert Step

This command allows the user to insert a step in the
opened protocol.

1. Select Insert Step from the Edit menu. The New
Method Step window appears.

2. Select (highlight) the desired step to insert from the
drop down menu list. Select OK.

3. The step will be inserted at the selected step num-
ber in the protocol and the instructions originally at
that number will be moved to the next step number.
(For example, if step 5 now is the step “Heater con-
trol” and is selected, when the step “Rinse needles”
is inserted, it will become step 5 and Heater control
moves to step 6.)
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Append Step

This command allows the user to add or append steps to
an opened protocol.

1. Select Append Step from the Edit menu. The New
Method Step window appears.

2. Select (highlight) the desired step to insert from the
drop down menu list. Select OK.

3. The selected step will appear as the next step in the
opened protocol.

Edit Vial Contents Names

This command allows the user to edit the descriptions of
the vials’ contents and customize the name of each
reagent, solvent and enzyme solution.
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Note: Each of the vial names is associated with a specific
location on the ProGest for ease of use when method
editing. Refer to “Loading the work area” on page 17 for
more information.

To enter or change a vial contents description:

1. Select Edit Vial Contents Names from the Edit
menu. The Vial Contents Names window appears.

2. Select (highlight) the desired vial name.

3. Double-click on the name or select Edit to bring up
the Vial Contents Description window. Type in the
name or description of the vial contents. Select OK
when finished. The new description should appear
in the Vial Contents Names window and in any
subsequent steps that select it. Note: Any steps that
selected that source or reagent prior to changing the
contents description will not be updated until that
step is selected again.
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List of Steps

Below is a list of protocol steps available with the
ProGest. Depending upon the step selected, one or more
windows are required to enter the relevant information
needed for the completion of the step parameters. These
steps may be added by either Insert Step or Append
Step as discussed previously. For more information
about each step, refer to the page listed.

• Aliquot to each sample well—takes a quantity of liquid
from a vial or reservoir and distributes it to the active
wells on the sample plate. Refer to “Aliquot to each
sample well” on page 70 for more information.

• Heater Control—sets the temperature to either low (37°
C), high (60° C) or Off. Refer to “Heater Control” on
page 72 for more information.

• Incubate (purge, aliquot, delay)—directs the system to
purge one liquid from a sample tube and replace it with
another. The delay is provided to allow time for a reac-
tion to take place prior to the instrument moving on to
the next step. Refer to “Incubate (purge, aliquot,
delay)” on page 72 for more information.

• Move the sample rack—directs the system to move the
sample rack to a designated location. Refer to “Move
the sample rack” on page 76 for more information.

• Pipette from one vial to another—directs the system to
transfer liquid from one vial to another. This step can
also be used to stir the contents of a single vial. Refer to
“Pipette from one vial to another” on page 77 for more
information.
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• Rinse needles—directs the system to rinse the needles
both inside and out. Refer to

• Start a timer—directs the system to start a selected
timer but allows the method to continue running. Refer
to “Start a timer” on page 79 for more information.

• Time delay—directs the system to wait at this point in
the protocol. Refer to “Time Delay” on page 80 for
more information.

• Wait for timer—is a companion step to the ‘Start
Timer’ step. When the method reaches this step, pro-
cessing will stop until the specified timer has elapsed.
Refer to “Wait for a timer” on page 80 for more infor-
mation.

• Wait for the operator—this step directs the system to
pause and wait for the operator. Refer to “Wait for the
operator” on page 81 for more information.

Common Parameters

Several of the steps listed have similar parameters that
need to be entered for the step to be used. Some of these
common parameters are discussed below rather than
under each step to minimize repetition.

Diluter

This screen is found under several steps, such as Aliquot
to each sample well, Incubate (purge, aliquot, delay),
Pipette from one vial to another and Rinse needles.
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• In this screen the user can select aspiration and dis-
pense speed of the selected liquid. This value is in ml/
min. Choosing an appropriate speed for the dilutor is
important. When rinsing, a high speed is necessary to
achieve a good washing action. When handling fluids
with an air gap, care must be taken to preserve the air
gap. The speed at which the air gap is damaged
depends upon the volume of the air gap, the diameter of
the transfer tube between the needles and the syringe,
and the properties of the liquid being transferred. Typi-
cal working values for aspirate and dispense speeds are
5-10 ml/min.

• Air gap volume is also selected in this screen. This
value is in µl. Because the same needles and pumps are
used for all the fluid handling within the system, care
must be taken to avoid contamination. Before drawing
any liquid into the needles (aspirating), an air bubble
should be created in the tube. This separates the reser-
voir liquid always present in the tube from the liquid
being transferred. The air gap is adjustable; 10µl is a
typical value.
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• Equalization time is selected in this screen. Because the
air gap is elastic, it may be necessary to allow some set-
tling time after the dilutor has operated. This parameter
is know as equalization time and is adjustable for each
step. A typical value is 1 second.

• Discard volume is also selected in this screen. An addi-
tional safeguard against contamination is to draw-up
more fluid than is necessary, dispense the specified
amount and then discard the remainder. Steps such as
‘aliquot’ and ‘incubate’ have a parameter which speci-
fies a discard volume. When using a ‘pipette’ step, this
effect may be achieved by setting the aspiration volume
higher than the dispense volume.

• Droplet aspiration is another option that may or may
not be present under Dilutor depending upon the step
chosen. When present this feature is used to improve
fluid delivery accuracy. When dispensing to the sam-
ple, for example, slightly more liquid is dispensed than
specified by the ‘dispense volume’ alone. The syringe
then draws back by this amount to collect the droplet at
the tip of the needle. This parameter is normally set to
zero.

Rinse

This screen is found under two steps, Incubate (purge,
aliquot, delay) and Rinse needles.
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• This screen refers to washing the needles to avoid con-
tamination of the samples or reagents. This step per-
forms a two-stage rinse. First with the needles above
the rinse port so that the inside of the needles is
washed, then with the needles inside the rinse port so
that the outside of the needles is washed. The default
for both washes is 1000µl.

Source

This option in any of the pipetting or dispensing steps
opens a sub-menu or list of vial contents names.
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Vial positions are referenced to the vial contents names.
These positions are factory programmed as are other crit-
ical features and can not be accessed by the user. For
more information about the positions associated with
each vial content name, refer to “Appendix A: Trypsin
Digestion Kit” on page 113.

Aliquot to each sample well

This step takes a quantity of liquid from a vial or the res-
ervoir and dispenses it to each of the active wells in the
sample plate. The desired amount of reagent along with
the reagent name must be entered. An aspiration speed,
dispense speed, airgap volume (if liquid is drawn from a
vial rather than the reservoir), equalization time and dis-
card volume should also be entered.

• Aliquot:

• Customize the step with a description to show
what is being performed. This description is
displayed on the ProGest screen when this step
is being executed.

• Enter the reagent source of the aliquot to be
added to each sample well from the drop-down
menu list. Reservoir allows liquid from the res-
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ervoir to be added. This selection changes a
valve in the dilutor to allow liquid to be aspi-
rated directly from the reservoir bottle; the
sample probes do not move to the reservoir
bottle to aspirate the liquid.

• Enter the desired amount of reagent (in µl) to
be added.

• Dilutor:

• Select the desired aspiration and dispense time
(in ml/min; default speed = 10ml/min)

• Select an airgap volume (in µl), if desired. The
air gap is adjustable—10 µl is a typical value.

• Select an equalization time (in seconds).

• Select a discard volume (in µl).

Step Sequence:

• specified air gap is aspirated

• needle moves into source vial

• calculated volume of liquid is aspirated

• needles visit pairs of sample wells and dis-
pense specified amount of liquid

• specified ‘discard volume’ is dispensed to the
drain

Note: When the instrument is processing many wells, it
aspirates the maximum volume, dispenses to the first
wells, refills and continues dispensing to subsequent
wells.
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Heater Control

The ProGest Reaction Block is fitted with a heater, con-
trolled by a temperature controller built into the front
panel. The heater can be set to two different temperatures
within the method. The Heater Control step directs the
system to turn heater to low (37° C) or high (60° C) or
turn the heater off (ambient).

Incubate (purge, aliquot, delay)

This step directs the system to purge one liquid from a
sample tube and replace it with another. The delay or
hold time is provided to allow time for a reaction to take
place before the instrument moves on to the next step.
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• Incubate:

• Customize the step with a description to show
what is being performed. This description is
displayed on the ProGest screen when this step
is being executed.

• Enter the reagent source of the aliquot to be
added to each sample well from the drop-down
menu list.

• Enter the desired amount of reagent (in µl) to
be added.

• Enter the amount of hold time (in hours, min-
utes or seconds).

• Dilutor

• Select the desired aspiration and dispense time
(in ml/min; default speed = 10ml/min).

• Select an airgap volume (in µl), if desired.

• Select an equalization time (in seconds).

• Select a discard volume (in µl).

• Select a droplet aspiration (in µl).
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• Purge:

• Enter the amount of time for the nitrogen purge
(in seconds). Note: The needles move to a
‘purge’ position inside the pair of sample wells
and the nitrogen valve is opened to allow the
liquid in the wells to be purged into waste.

• Enter the amount of post purge time (in sec-
onds). This is a delay after the nitrogen is
turned off, to allow the nitrogen pressure to
decay. This is normally set to zero.

• Rinse

• Enter the amount of inside wash volume (in
µl). (Default is 1000µl)

• Enter the amount of outside wash volume (in
µl). (Default is 1000µl)
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• Dilutor

• Select the desired aspiration and dispense time
(in ml/min). (Default speed = 10ml/min).

• Select an airgap volume (in µl), if desired.

• Select an equalization time (in seconds).

• Select a discard volume (in µl).

Step Sequence:

• specified air gap is aspirated

• needles move into source vial

• calculated volume of liquid is aspirated

• needles visit first pair of samples, moving to a
lower ‘purge’ position

• the nitrogen valve is opened for a specified
time

• then needles rise to their normal ‘dispense’
position

• specified volume of liquid is dispensed (com-
plete with droplet aspiration, if specified).
Note: Refer to page 68 for more information.

• sequence repeats for all active samples

• specified discard volume is dispensed into the
drain

• a rinse is performed (similar to rinse step)

• processing halts until specified ‘hold time’ has
elapsed Note: The specified hold time starts at
the beginning of the step rather than the end—
it includes the time necessary to perform all the
purging and dispensing and the final rinse.
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Move the sample rack

This step directs the system to move the sample rack to a
designated location.The ProGest operates with the rack in
two positions. The first, to the left of the instrument, is
used when liquid purged from the sample wells is to be
discarded into the drain. The second position, to the right,
is used when it is important to catch the liquid purged
from the wells into another plate. Caution: It is strongly
recommended that you use the standard moves as it is
very easy to perform rack move operations that may
cause damage to the ProGest.

Select the type of move desired—from right side, left
side, from left side to extraction position, or custom
move. The recommended sequence is to move the rack to
the left position, then to move the rack to the extraction
position.

• Collect sample rack from right hand side—
moves the rack from any position at the right
of the instrument into its starting position. This
should normally be followed by a ‘Collect
from left’ step.

• Collect sample rack from left hand side—
moves the rack from any position at the left of
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the instrument to the correct starting position.

• Move to extraction position—this step
assumes the rack is in the correct starting posi-
tion and then moves it to the right hand extrac-
tion position. Note: After the move, the system
needs to know that the samples are now in a
different position—for this reason, the ‘update
sample position’ must be set. If you do not
select it on this move, the ProGest will move
the sample rack to the right, but continue to
visit the positions on the left to dispense to the
plate. Caution: Do not perform this move
unless you know that the rack is already in
the normal starting position.

• Enter custom move settings (in mm/10, that is,
tenths of a millimeter) for start position and
end position—this step allows for complete
flexibility over the move. Caution must be
used when experimenting with custom
moves.

• Update sample position after move—this
option is normally used when performing the
move to extraction position. It tells the ProGest
that after the move has been executed, it should
expect to find the sample plate in a new posi-
tion. The ProGest always starts by assuming
that the samples are in the left hand position.

Pipette from one vial to another

This step directs the system to transfer liquid from one
vial to another. It can also be used to stir the contents of a
single vial.
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• Pipette:

• Customize the step to show which reagent is
being added to which destination in the
description text field.

• Enter the reagent source of the aliquot to be
added from the drop-down menu list.

• Enter the reagent destination from the drop-
down menu list. Note: A useful feature to mix
the contents of a position is by specifying the
source and destination as the same.

• Enter the aspiration volume (in µl).

• Enter the dispense volume (in µl).

• Dilutor

• Enter an aspiration and dispense speed (in ml/
mm)

• Select an airgap volume (in µl), if desired.

• Select an equalization time (in seconds).

Step Sequence:

• specified air gap is aspirated

• needles move into source vial
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• specified volume of liquid is aspirated

• needles move to destination vial

• specified volume of liquid is dispensed

• if aspiration volume is greater than the dis-
pense volume, the excess is discarded to waste

Rinse needles

This step directs the system to wash the needles to avoid
contamination of the samples or reagents. Refer to
“Rinse” on page 68 for more information.

Start a timer

This step directs the system to start a selected timer but
allows the method to continue running. You may have up
to four timers running simultaneously in a method. Once
a timer has been started, it steadily counts down to zero,
regardless of what else the ProGest is doing. For exam-
ple, you start timer 1 for 10 minutes, the ProGest pro-
ceeds with the run steps, which takes 5 minutes, then
waits for timer 1 to count down to zero (system waits for
a further 5 minutes). this step should be used in conjunc-
tion with a ‘Wait for a timer’ step.
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• Customize a description of timer information
in the text field

• Select the desired timer

• Enter a delay time in hours, minutes and sec-
onds (if desired)

Wait for a timer

This step is a companion to the ‘Start Timer’ step. When
the method reaches this step, processing will stop until
the specified timer has expired (reached zero). It is
important to ensure that the timer number you specify in
the ‘Wait for Timer’ step matches that which you started
in the ‘Start Timer’ step.

Time Delay

This step directs the system to wait at this point in the
protocol. A delay step will stop the processing of the
method for the specified amount of time. Nothing else
will happen during the delay period. The wait time can be
entered in hours, minutes and seconds.
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Wait for the operator

This step directs the system to pause and wait for the
operator. A message is displayed for the operator and
processing will continue when the operator presses the
OK button on the ProGest screen. Note: Make sure the
sample tray is not moved during this time as the tray is
not homed after this pause.
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Network

This command allows the user to communicate with one
or more ProGest, Investigator ProMS or other Genomic
Solutions instrument via a cable connected to one of your
PC’s serial ports.

Settings

This command allows the user to enable or disable the
network feature and to select the particular port on your
PC to which the network is connected.

1. Select Settings from the Network menu. The Net-
work Settings window appears.

2. Select to network systems by checking the Enable
Genomic Solutions network checkbox.

3. Select the correct COM port to be used (COM 1 to
COM 9—normally COM 1 or 2).

4. This screen also shows the maximum number of
network addresses it queries (one for each instru-
ment networked). Note: The system always
defaults to 8.

5. When you are finished, select OK to close the win-
dow.

Network Status

The network view shows a short indication of the status
of each instrument networked.
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In the screen above, one ProGest instrument is networked
to the PC. To see more detailed information, double-click
on the device in the network view. The detail page will
include information about the progress of a run, if the
instrument is running and steps to start the instrument
from the PC if it is not running.

ProGest Instrument
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Controlling ProGest Remotely

From the Method Editor, it is possible to start, stop, pause
the system and select sample positions.
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Start ProGest Remotely

To start the ProGest from the Method Editor:

• Click the right mouse button on the device in
the network view. A menu list will appear.

• Select Start Device. A message will appear
asking if you would like to enter a start delay.

• If Yes, enter the desired delay time in hours
and minutes. After the delay, the ProGest will
start to run the method that was last sent to it
(or selected on the instrument itself).

If No, the ProGest will start to run the method that was
last sent to it (or selected on the instrument itself).
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Stop or Pause ProGest Remotely

To stop or pause the ProGest from the Method Editor:

• Click the right mouse button on the device in
the network view. A menu list will appear.

• Select Stop Device. The ProGest will pause at
the end of its current movement.

• A message will be displayed on the PC asking
if you would like to Continue the run or Cancel
it. Select Continue to continue running the
protocol.

• Select Cancel to stop the protocol.

Select Sample Positions Remotely

To change the active sample wells in the sample plate on
the ProGest by the Method Editor:

• Double-click on the device in the network
view. A menu list will appear.

• Choose Select Tubes. A picture of a 96 well
plate will appear. The Method Editor will
retain which wells were selected last.

• You may select or de-select pairs of wells by
clicking on the appropriate part of the plate.

• When you are finished, select OK. The new
plate settings will be sent to the ProGest and
stored within the ProGest.

Method Transfer

To send a method from the Method Editor to the ProGest:
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• Click the right mouse button on the device in
the network view. A window will appear.

• Select Send Method. The method currently
loaded (open) in the editor will be sent to the
ProGest. It will not be started automatically.
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5 Maintenance

The ProGest has been designed to reduce maintenance to
a minimum. However, some maintenance will eventually
be required. Only maintenance operations described in
this manual should be carried out by the user. Other
maintenance operations not described here should be
referred to Genomic Solutions Technical Service.

Warning: Before beginning any maintenance operations,
the system should be powered off by the On/Off switch
and the power cord disconnected from the power outlet.

General Safety Procedures

• The instrument must be operated by trained personnel
only. It is important to know and understand safety reg-
ulations regarding the instrument and the contents of
the operator’s manual.

• Chemicals must be handled with care. Please observe
the current national safety regulations regarding the use
and disposal of the following chemicals:

• Acetonitrile (ACN)

• Ammonium Bicarbonate (ABC)
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• Formic Acid (HCOOH)

• Dithiothreitol (DTT)

• Iodoacetamide (IAM)

• Enzymes

• Wear safety glasses, gloves and a lab coat during
reagent preparation and instrument set-up. If incidental
spillage occurs, carefully clean up the spillage taking
into account the nature of the spilled liquid and the nec-
essary precautions.

• Prepare reagents in a fume hood.

• During operation the instrument generates vapors
which pose a health hazard. The ProGest should only
be operated with the cover closed in a well ventilated
location. Please consult your organization’s safety reg-
ulations as to whether this instrument should be ope-
arted in a specially designated area or fume hood.

• Warning—Please make sure that nothing interferes
with the movement of the instrument parts. Nothing
should be placed in or around the field of movement of
either the horizontal or vertical arm of the robot.

• Warning—You must not operate the robot without
closing the protective cover as the moving arm and
needle can lead to injuries.

• The leakage current of this instrument is within the
limits allowed by international safety standards for lab-
oratory equipment. An efficient ground connection is
imperative for the protection of the user.

• Cleaning, dismantling, maintenance, adjustment and
repair should only be performed by personnel trained
in such work, and who are aware of the possible dan-
gers involved.
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• Warning—Voltages present inside the instrument are
potentially dangerous. If there is a problem with the
instrument, make sure to switch the unit off. The power
cord should be removed until qualified service person-
nel have repaired it. This is to prevent anyone from
inadvertently using the instrument, thus causing possi-
ble harm to themselves or damage to the instrument
itself.

• Genuine spare parts and consumables were specially
designed for the instrument. We must exclude any war-
ranty for damage resulting from:

• modifications of the software

• modifications of the hardware

• operation deviating from the manual

• use of non-genuine parts and consumables

Installation

Installation of the system is carried out by Genomic Solu-
tions personnel or their representative. Please do not try
to install the system yourself.

Changing the dilutor syringe

If the syringe is damaged or does not work properly, an
exchange is required. Please replace the syringe with the
correct Genomic Solutions part.

Note: Make sure that the piston operating rod is NOT in
the uppermost position. Use the software to lower the
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piston operating rod as follows. This allows you to dis-
mount and mount the syringe without risk of damaging
the rod or syringe.

1. Switch on the instrument and press Plate Con-
figuration at the keypad.

2. Select Setup from the keypad.

3. Press the key Load Syringe. The piston operat-
ing rod moves to the lower position. The instru-
ment screen changes then changes to prompt the
user.

4. Unscrew the four screws holding the plexiglass
syringe assembly cover.
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5. Unscrew the mounting screw at the bottom of the
piston operating rod.

6. Unscrew the syringe from the valve using the
knurled nut at the top of the syringe (1).

7. Mount the new syringe. Screw the threaded end
of the the syringe body into the valve.

8. Lower the piston so that it comes it contact with
the piston holding screw. Note: For new syringes
the piston may be difficult to lower. Attach the
syringe, press OK and while the drive is slowly
being raised, align the syringe and base until it
homes properly.

9. Tighten the mounting screw at the bottom of the
piston operating rod.

1
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10. Press OK to bring the syringe back to home posi-
tion.

11. Press Done until you get back to the main menu.

12. Replace the plexiglass cover making sure to re-
position the feed line at the right side of the win-
dow to prevent line damage.

Probe Adjustment

If the reaction tray is accidentally moved during a run, a
probe crash may be possible. As a result, the inner black
probes may be pushed up inside the outer stainless steel
ones. Before the run can be re-started, the inner probes
must be adjusted to the correct length. To reset the inner
probes, the following procedure must be observed:

• Turn the ProGest off at the main switch (front
of instrument).

• Remove the probe assembly from the robot
arm by unscrewing the black thumbscrew, and
lifting the probe assembly clear.

• Undo the brown locking screw that holds the
probes in the white block.

• Carefully readjust the position of the blue fer-
rule on the inner probe and tube as shown.
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• Push the probe back into the assembly and
tighten the locking screw in the white block.

• The correct protruded length of the inner probe
from the outer stainless steel probe is 8.0 mm.

8.0 mm
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Priming the dilutor

If the system has not been used for some time, it may be
necessary to fill the syringe and the tubing leading to the
reservoir with reservoir fluid and purge air. It is also good
practice to prime the syringe before each run.

1. Select Plate Configuration from the keypad.

2. Select Setup from the keypad.

3. Press Prime Dilutor to start priming.

4. Press Stop Dilutor after about 10 strokes to can-
cel priming.

5. Check for bubbles in the syringe or tubing. Con-
tinue priming until no bubbles are seen.

Upgrading Software

If a new version of software needs to be loaded into the
ProGest instrument, it can be loaded manually by insert-
ing a floppy disk with the software downloaded onto it
into the disk drive on the front of the instrument. Note:
Upgrades to the software will be accessible to be down-
loaded from the Genomic Solutions website. Copy the
downloaded file to a blank formatted 1.44MB 3.5”
floppy disk.

1. Select Plate Configuration from the keypad.

2. Select Setup from the keypad.

3. Insert the floppy disk with the new software
upgrade on it into the disk drive at the front of
the ProGest instrument.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Chapter 5: Maintenance

Investigator ProGest 3/28/01 97

4. Press Upgrade SW.

5. Follow the instructions on the display. Press OK.

6. To access the new software, power the ProGest
off at the main power switch (front of instru-
ment), remove the floppy disk from the disk
drive and then turn the ProGest back on again.

Autosampler Control

Some of the functions of the Autosampler are found
under the Setup menu under Plate Configuration. These
allow the user access to a nitrogen valve check and a
heater check. Note: Autosampler functions that pertain to
the robotic arm (Ref 1, Go XY, Go Z and Free) should be
accessed by service personnel only. If you encounter any
problems with the movements of the robotic arm please
contact Genomic Solutions Technical Service for assis-
tance.

Check Nitrogen Valve

After a long period of inactivity or when there is a sus-
pected malfunction, it is possible to access the nitrogen
valve through the ProGest software.

1. Select Plate Configuration from the keypad.

2. Select Setup from the keypad. The Engineering
Options window appears.

3. Select Nitrogen from the keypad to turn the
valve on. You should be able to hear the valve
click and hear the hiss of the nitrogen coming
through the stainless steel probes. A further
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check would be to undo the probe assembly from
the robot arm using the large finger screw and to
dip the end of the probes into a container of
water to see if the nitrogen is bubbling through
both outer probes.

4. If Nitrogen appears to be coming through the
probes, select Nitrogen again to turn the valve
off.

5. If there is no hissing noise, or no apparent bub-
bling of Nitrogen through the water, press Nitro-
gen again to turn the valve off. Make sure the
ProGest is connected to a compressed nitrogen
tank and that the tank is not empty.

6. If the problem persists, contact Genomic Solu-
tions Technical Service for assistance.

Check Heater

The parameters of the temperature controller have been
carefully set at the factory, but it may be necessary to
check the function.

1. Select Plate Configuration from the keypad.

2. Select Setup from the keypad. The Engineering
Options window appears.

3. Select Heater. ‘Low’ will be displayed and the
heater will start to heat the tray to 37° C. The dis-
play on the heater controller (on the front of the
ProGest) will show two temperatures. The top
temperature will be the actual sensed tempera-
ture of the tray, and the bottom reading will be
the demand temperature. Note: All temperature
controls should be made through the software.
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The temperature controller on the front of the
ProGest should never be adjusted.

4. If the Heater button in the Setup window is
pressed again, then ‘high’ will be displayed in
the setup window and the heater will start to heat
the tray to 60° C. The top temperature reading on
the temperature controller (front of ProGest) will
be the actual sensed temperature and the reading
below will be the demand temperature.

5. Press Heater again and the heater will be turned
off. You may also select Done to turn the heater
off.

6. If there is a problem with obtaining either heater
temperature, contact Genomic Solutions Techni-
cal Service for assistance.

Network Address

If multiple ProGest or ProMS units are to be networked
together, a unique network address must be selected for
each instrument to enable communication between each
specific unit and the network. To access this Network
Address:

1. Select Plate Configuration from the keypad.

2. Select Setup from the keypad.

3. Scroll up by selecting the Address + button, or
down using the Address - button until the
desired address number is reached.

4. Select Done when finished.
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Cleaning

• The protective cover should be washed with warm dis-
tilled water. Do not use Methanol or any other solvent!

• The tray and the surface of the instrument can be
cleaned with a cloth dipped in soapy water.

• The needle guide and needle should be washed with
methanol using a spray bottle.

Shut down (long periods)

Some of the chemicals used are hazardous material
which must be disposed of properly. Check with your
safety officer and follow the regulations of your state or
institute.

For long periods of shut down time, we recommend the
following procedure:

1. Switch off the system and remove the power
cables.

2. Empty and clean dilutor reservoir and waste bot-
tle.

3. Empty and clean work area.
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6 Troubleshooting

The ProGest is a sturdy instrument assembled from reli-
able parts. However, as in every instrument, there are
possibilities of unexpected malfunction. This chapter will
give you an overview of some possibly occurring failures
and solutions of the system.

Machine Test Method

A quick check on the correct operation of the ProGest
would be the “Machine Test Method”. This is found
under the Method list on the instrument. This method
will dispense solvent (50µl) into the 96 well reaction
plate in the reaction block. A further quantity of another
solvent is then added to the reaction plate.The system
stops and asks the user to check for any drips by looking
under the bottom of the tray (don’t move it) before pro-
ceeding. The plate will be moved to the right hand side of
the work area .It is then purged with nitrogen and the liq-
uid collected in the collection plate underneath. There
should be equivalent volumes in every well.

To set up the system for the ‘Machine Test’:

1. Add distilled water to Solvent positions A and D.
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2. Be sure to place both a sample plate with pierced
sealing film and a collection plate on the instru-
ment.

3. Power the system on. Select Machine Test Method
from the protocol list for the desired method.

4. Select Plate Configuration to select the desired
sample positions. (Refer to “Plate Configuration”
on page 27 for more information.) It is usual to
“select all” for this test of the instrument. Note: Be
sure to pierce the film sheet.

5. Press Start to start the system. Do not select a
Delay Start Time.

The system will home itself and then start the process.
The following steps should occur in the following order.
If any step does not occur as described, or if the system
halts during the run, call Technical Service for assistance.

Steps:

• Rack containing 96 well reaction plate moves
to the run position (left hand side).

• Film is pierced.

• The heater turns off.

• Rinse needles (inside and out).

• System dispenses 50µl of Solvent A into the
reaction plate.

• The heater switches to High.

• System dispenses 50µl of Solvent D into the
reaction plate.

• The method pauses now to allow the user to
examine the dispensed liquid in the sample
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tray, if required.

• Press OK to continue the method.

• Sample plate moves to the right hand collec-
tion position for extraction.

• Reaction plate is purged with nitrogen.

• The heater is turned off.

• Wait while run finishes.

• Check for liquid in the 96 well collection plate.
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Troubleshooting Tips

Table 1:

Problem Possible Cause Solution

Green LED control
light at the right
arm side of the
robot does not light
up

1. Power cord
unplugged.
2. Blown fuse.

1. Check the power
source.
2. Call Technical
Service.

Green LED of dilu-
tor does not light up

1. Power cord
unplugged.
2. Blown fuse.

1. Check the power
source.
2. Call Technical
Service.

Display of keypad
stays dark

1. Contrast button
on front of instru-
ment turned.
2. Power cord
unplugged.
3. Blown fuse.

1. Adjust contrast
with button on front
of instrument.
2. Check the power
source.
3. Call Technical
Service.

Dilutor syringe
leaks

A small leak can
develop after sev-
eral months of
operation.

1. Dismantle the
syringe and clean.
2. Change the
syringe.
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Dilutor valve leaks The dilutor valve
has a safety outlet
at its left side. If the
probe is blocked,
the solvent can leak
through this outlet.

1. Remove and
check the probe.
See “Probe Adjust-
ment” on page 94.
2. Check the trans-
fer tube for bends
and clogging.

Robot stopped dur-
ing execution

Power failure Check the power
source.

Table 1:

Problem Possible Cause Solution
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At the display, this
message appears:
“Problem with
Autosampler” fol-
lowed by some
softwarecommands
and the last com-
mand that was
issued:
Z-drive error;
X-drive error or
Y-drive error

This happens if
something hinders
the movement of
the vertical arm (Z
drive) of the robot
or something hin-
ders the movement
of the horizontal
arm (X,Y drive).

1. Check the work
area.
2. Check the align-
ment and orienta-
tion of the rack.
3. If the inner
probes have been
pushed up inside
the stainless steel
outer ones, they
need to be reset.
See “Probe Adjust-
ment” on page 94.
4. If the probe is
damaged, replace it.
Note: Always use
original consum-
ables and spare
parts supplied by
Genomic Solutions.

Table 1:

Problem Possible Cause Solution
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Dilutor syringe
fails to prime at the
beginning of a run,
or dispense liquid
correctly during a
run

Syringe plunger
may have become
detached from the
threaded coupling.
(The plunger is
held in place by a
single 0.05” grub
screw.)

To reset the
syringe:
1. Turn the unit off.
2. Unscrew the four
screws holding the
clear acrylic cover
in position.
3. Pull the syringe
plunger down into
the threaded cou-
pling and tighten
the 0.05” grub
screw.
4. Replace the clear
acrylic cover and
check the opera-
tion of the syringe.
(See “Priming the
dilutor” on
page 96.)

Air bubbles cannot
be cleared from
syringe during
priming

Screw couplings
may be loose
allowing air to
enter system

1. Turn the unit off.
2. Check the screw
couplings to the
reservoir bottle,
dilutor valves and
syringes. Note: All
screw couplings
should be fingertip
tight.

Table 1:

Problem Possible Cause Solution
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Rack is accidentally
moved during oper-
ation

ProGest cover is
left open during run

The run must be
PAUSED and then
CANCELLED. The
rack will move to
the correct position
when a new run is
started.

Rack is accidentally
moved during run
and inner probes
get pushed up
inside the stainless
steel outer probes.
An Autosampler
error message and
step number
appears on the dis-
play.

ProGest cover is
left open during
run.

1. Press OK to clear
the error message
and cancel the run
—or—

turn the unit off.
Before proceeding,
the probes must be
correctly read-
justed. See “Probe
Adjustment” on
page 94.
Note: The tray will
be moved to the
correct position
when a new run is
started.

Table 1:

Problem Possible Cause Solution
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Reaction wells not
emptied by nitro-
gen pressure

1. Nitrogen supply
not turned on.

2. Malfunction of
nitrogen purge
valve.

3. Wrong reaction
tray used.

1. Check nitrogen
supply at rear of
unit.
2. Make sure nitro-
gen is turned on.
See “Check Nitro-
gen Valve” on
page 97.
3. 96 well trays
must be red ones
with small holes in
the bottom.

Reaction wells do
not drain com-
pletely

1. Sealing film not
sealing around
probe

2. Reaction plate is
dirty.

3. Nitrogen pres-
sure incorrectly set.

1. Check that the
sealing film was
perforated cor-
rectly. See “Prepar-
ing the Reaction
Plate” on page 22.
2. Make sure the
reaction plate is
new.
3. Adjust nitrogen
pressure to at least
15psi (1bar).

Table 1:

Problem Possible Cause Solution
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Strange values at
the display of the
temperature con-
troller

1. Heater cable not
connected.

2. Other malfunc-
tion

1. Firmly connect
and secure the
cable of the reac-
tion block to the
connection under
the workstage.
2. Check the reac-
tion block. (“Check
Heater” on
page 98) If not
working, contact
Technical Services.

No peptides found 1. Too little protein
loaded.

2. Wrong reagents
and buffers.
3. Enzyme not
working.
4. Wrong method.

5. Problems in
reagent delivery.

1. Run control
digests of a known
protein such as
BSA at different
concentrations
using freshly pre-
pared reagents.
2. Check reagents.

3. Check enzyme.

4. Check method
selected. Note:
Machine test does
not do digestion.
5. Check probes.

Table 1:

Problem Possible Cause Solution
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Technical Assistance

If you need technical assistance and you are in North
America or Europe, contact the Ann Arbor, Michigan
office:

Telephone:(Toll Free) +1 877-GENOMIC (436-6642)

or +1 734-975-4800

FAX: +1 734-975-4808

Too many “wrong”
peptides found

1. Contamination.
This is most likely
if the contaminat-
ing peptides can be
assigned to a pro-
tein such as kera-
tine.
2. More than one
protein in the gel
piece isolated.
3. Incomplete
digest of a very
large protein.
4. Heavily modified
protein which is
difficult to identify.

Repeat the experi-
ment with care-
fully cleaned
material and
include control pro-
teins for compari-
son.

Table 1:

Problem Possible Cause Solution
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For rest of world, please contact your local distributor or
contact Genomic Solutions by E-mail:
help@genomicsolutions.com

If you are in Japan, call:

Tel. +81 3-3280-0990

FAX: +81 3-3280-0991

On the internet:

http://www.genomicsolutions.com

or contact us at:

Genomic Solutions Inc.
4355 Varsity Drive, Suite E
Ann Arbor, MI 48108

or at our Lansing Manufacturing facility:

Genomic Solutions Inc.
3120 Sovereign Drive, Suite A
Lansing, MI 48911
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Appendix A: Trypsin
Digestion Kit

The Genomic Solutions ProGest Trypsin Digestion kit is
designed for the tryptic digestion of protein gel slices or
spots using the Investigator ProGest Protein Digestion
Station.The reagents contained in this kit will process up
to 96 samples using any of the three protocols provided
with the ProGest. In addition to these contents, HPLC
grade acetonitrile (100ml) and 18 megohm-cm water are
required. The following instructions describe reagent
preparation and placement in the ProGest sample work
area.

Safety

This kit is for use by qualified laboratory staff and should
be treated with care. Protective gloves should be worn at
all times to protect the user and to minimize possible ker-
atin contamination.

Reagent Preparation

Note: Use only high quality 18 megohm-cm water for
preparation of all solutions. Use solutions immediately
after preparation.
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Prepare Solvents (C) and (D)

To prepare Solvent C (50mM Ammonium Bicarbonate),
resuspend the contents of Solvent vial C in 30 ml of 18
megohm-cm water. Invert the vial several times to mix
well. Keep at 4° C until use. This solution is stable for 5
days at 4° C.

To prepare Solvent D (25mM Ammonium Bicarbonate),
resuspend the contents of Solvent vial D in 30 ml of 18
megohm-cm water. Invert the vial several times to mix
well. Keep at 4° C until use. This solution is stable for 5
days at 4° C.

Prepare DTT Reagent (A)

To prepare Reagent A (10mm dithiothreitol solution),
add 10 ml of prepared Solvent D (25mM Ammonium
Bicarbonate) to the contents of vial A. Invert the vial sev-
eral times to mix well. Keep at 4° C until use. This solu-
tions is stable for 24 hours at 4° C.

Prepare Iodoacetamide Reagent (B)

To prepare Reagent B (100mM iodoacetamide solution),
add 10 ml of prepared Solvent C (50mM Ammonium
Bicarbonate) to the contents of vial B. Invert the vial sev-
eral times to mix well. Keep at 4° C until use. This solu-
tion is stable for 24 hours at 4° C.

Prepare Trypsin Enzyme (C)

To prepare Trypsin Enzyme, open the small vial (G) con-
taining Trypsin Resuspension Buffer. Add 300 µl of
Trypsin Resuspension Buffer to the 20µg lyophilized
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trypsin powder (Promega) in the small glass vial pro-
vided in the zip-lock plastic bag. Draw the solution up
and down in a pipette tip several times to mix well and
then transfer the entire volume into Trypsin Enzyme vial
C. Keep at 4° C until use.

Prepare Formic Acid Solvent (E)

No further preparation is needed. Use solution as pro-
vided.

Prepare Water Solvent (F)

Add 30 ml of 18 megohm-cm water to the empty Solvent
vial F.

Vial Placement

Place the prepared reagent vials in the ProGest sample
work area as shown in Fig. 1.

Fig. 1
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Running the Protocol

Follow the instructions in “Chapter 2 Operation” to run
the system, selecting the GSI Trypsin Digestion Protocol
as the method of choice.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Appendix B: ProGest Validation Kit

Investigator ProGest 3/28/01 B - 117

Appendix B: ProGest
Validation Kit

The ProGest is a fully automated workstation designed
for high throughput in gel protein digestion. The ProGest
validation kit provides a set of standard proteins to aid in
the set-up and validation of the instrument. In addition to
the ProGest Validation Kit, the following reagents, kits
and equipment will be required:

• ProGest Trypsin digestion kit Cat. No. 80-0210

• Acetonitrile

• Vacuum microcentrifuge with a 96 well microplate
rotor

• ProMS or MS

Kit Contents

The ProGest Validation Kit contains the following com-
ponents:

• 96 well pink microplate containing approximately 1-5
picomoles of Coomassie blue stained protein standards
in gel plugs. The following standard proteins are
included:

• Soybean Trypsin Inhibitor
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• Carbonic Anhydrase

• Ovalbumin

• Glutamate Dehydrogenase

• Bovine Serum Albumin

• ProMS Matrix Solution

• ProMS Peptide Matrix (α−cyano-hydroxy-cinnamic
acid)

Instructions

1. Prepare reagents for the ProGest using the
ProGest Trypsin Digestion kit. Follow the
instructions in the kit for reagent preparation and
placement on the ProGest.

2. Remove the pink 96 well plate from the ProGest
Validation kit plastic ziplock bag. Carefully tap
the pink plate on a flat surface to ensure that the
blue protein gel plugs are all on the bottom of the
wells.

3. Remove the plate cover carefully.

4. Follow the instructions starting with “Loading
the reaction wells” on page 20 to run the ProGest
using the Default Trypsin Digestion protocol.

5. When the run has completed and the peptides are
extracted into the blue plate, place the blue plate
in a vacuum microcentrifuge fitted with a 96 well
microplate rotor and evaporate to dryness.
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Preparing Peptides for MALDI-TOF

1. Remove the small vials of matrix and matrix
solution from the small ziplock bag labeled
ProMS Matrix.

2. Add the matrix solution to the vial containing the
α-cyano-hydroxy-cinnamic acid matrix.

3. Shake the vial to mix the contents thoroughly;
the matrix will not completely dissolve in the
solution.

4. If using the ProMS workstation, resuspend the
peptides in the blue plate in 100µl of 10%
Formic Acid.

5. Place the tube of prepared matrix solution in the
ProMS workstation and follow the instructions in
the ProMS operator’s manual to spot the MALDI
plate.

6. If spotting onto a MALDI plate manually, add
1-2 ml of the supernatant from the matrix mix-
ture directly to the dried peptides and spot onto
the MALDI plate.

MALDI-TOF Results

The results that can be expected from mass spectrometry
of the standard peptides on a MALDI-TOF mass spec-
trometer are shown in Figures 1 through 5. The illus-
trated spectra were acquired on a PE BioSystems
Voyager DE RP PRO MALDI TOF mass spectrometer in
reflectron mode. The approximate mass accuracy was
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20ppm. The database searches were conducted using Pro-
tein Prospector software and using the Swiss Prot
sequence database.

(Fig. 1)
Mass spectrum of the peptide digest from Sample #1
obtained using the ProGest Validation kit.

828.445

1163.61

1211.65

1277.67

1432.81

1480.86

1538.69

1554.69

1612.7

1762.93

1819.93

1886.04
1946.96

2032.1

2211.1

2263.18

2807.33

3061.4

3215.34

Search Results

1. 7/15 matches (46%). 24005.4 Da, pI = 4.99. Acc. # P01070. SOYBN.
TRYPSIN INHIBITORS A AND C PRECURSOR (KUNITZ).

m/z MH+ Delta
submitted matched ppm start end Peptide Sequence

1163.6154 1163.6424 -23.2444 77 87 (K)GIGTIISSPYR(I)
1211.6512 1211.6788 -22.7978 90 100 (R)FIAEGHPLSLK(F)
1432.8139 1432.8276 -9.5568 77 89 (K)GIGTIISSPYRIR(F)
1480.8615 1480.8640 -1.7076 88 100 (R)IRFIAEGHPLSLK(F)
1538.6903 1538.7062 -10.2992 131 143 (K)IGENKDAMDGWFR(L)
1554.6880 1554.7011 -8.4403 131 143 (K)IGENKDAMDGWFR(L) 1Met-ox
1762.9313 1762.9339 -1.5252 72 87 (R)NELDKGIGTIISSPYR(I)
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(Fig 2)
Mass spectrum of the peptide digest from sample #2
obtained using the ProGest Validation kit.

842.51

899.545

979.477

1018.51

1334.73

1581.81

1636.43

1685.93

1709.9

1738.9

2098.85

2141.01

2198.21

2250.06

2321.1

2353.11

2584.13

2712.33

2807.33

2852.5

2868.44

2910.37

3134.47

3167.54

Search Results

1. 8/24 matches (33%). 28982.7 Da, pI = 6.40. Acc. # P00921. BOVIN.
CARBONIC ANHYDRASE II (EC 4.2.1.1) (CARBONATE DEHYDRATASE II).

m/z MH+ Delta
submitted matched ppm start end Peptide Sequence

979.4771 979.4849 -7.9683 80 88 (K)DGPLTGTYR(L)
1018.5098 1018.4958 13.7518 18 26 (K)DFPIANGER(Q)
1581.8137 1581.8178 -2.5899 113 125 (K)YAAELHLVHWNTK(Y)
1709.9011 1709.9127 -6.8131 112 125 (K)KYAAELHLVHWNTK(Y)
2098.8519 2098.8776 -12.2459 58 75 (R)MVNNGHSFNVEYDDSQDK(A)
2198.2097 2198.2185 -4.0186 36 56 (K)AVVQDPALKPLALVYGEATSR(R)
2852.5009 2852.4769 8.4067 226 250 (R)TLNFNAEGEPELLMLANWRPAQPLK(N)
2868.4453 2868.4718 -9.2435 226 250 (R)TLNFNAEGEPELLMLANWRPAQPLK(N) 1Met-ox
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(Fig 3)
Mass spectrum of the peptide digest from sample #3
obtained using the ProGest Validation kit.

756 .356

834 .467

842.511

1242.66

1345.76

1425.76

1522.82

1571.72

1597.73

1687.87

1699 .87

1767.78

1823 .8

1859

1874 .98

1911.87

2008.98

2196.04

2281.22

2326.34

2476.34 2807.35 3237.63

3337 .8

Search Results

1. 8/24 matches (33%). 42750.3 Da, pI = 5.19. Acc. # P01012. CHICK.
OVALBUMIN (PLAKALBUMIN) (ALLERGEN GAL D 2) (GAL D II).

m/z MH+ Delta
submitted matched ppm start end Peptide Sequence

1345.7625 1345.7381 18.1611 370 381 (K)HIATNAVLFFGR(C)
1571.7220 1571.7164 3.5389 187 199 (K)AFKDEDTQAMPFR(V) 1Met-ox
1597.7271 1597.7168 6.4393 264 276 (K)LTEWTSSNVMEER(K) 1Met-ox
1687.8673 1687.8404 15.9714 127 142 (R)GGLEPINFQTAADQAR(E)
1859.0006 1858.9663 18.4448 143 158 (R)ELINSWVESQTNGIIR(N)
2008.9777 2008.9464 15.5981 340 359 (R)EVVGSAEAGVDAASVSEEFR(A)
2281.2197 2281.1828 16.1686 85 104 (R)DILNQITKPNDVYSFSLASR(L)
2476.3378 2476.3121 10.3678 159 181 (R)NVLQPSSVDSQTAMVLVNAIVFK(G) 1Met-ox
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(Fig 4)
Mass spectrum of the peptide digest from sample #4
obtained using the ProGest Validation kit.

741.384

756.333

799.394

834.472

842.51

956.512

963.539

1000.46

1016.44

1027.55

1057.5

1210.68

1219.59

1350.44

1425.64

1495.71

1676.55

1737.89

1747.88

1894.09

1917.93

1931.04

2211.1

2242.17

2279.13 2561.33

2662.36

2807.3 3324.68

Search Results

1. 7/29 matches (24%). 55561.6 Da, pI = 8.35. Acc. # P00366. BOVIN.
GLUTAMATE DEHYDROGENASE (EC 1.4.1.3) (GDH).

m/z MH+ Delta
submitted matched ppm start end Peptide Sequence

956.5120 956.5205 -8.8885 397 403 (R)LTFKYER(D)
963.5393 963.5264 13.4032 471 478 (K)YNLGLDLR(T)
1000.4631 1000.4562 6.8996 12 19 (K)MVEGFFDR(G)
1016.4431 1016.4511 -7.8822 12 19 (K)MVEGFFDR(G) 1Met-ox
1210.6772 1210.6948 -14.5273 296 306 (K)LQHGTILGFPK(A)
1425.6392 1425.6286 7.4293 68 79 (R)DDGSWEVIEGYR(A)
1737.8936 1737.8924 0.7087 424 439 (K)HGGTIPIVPTAEFQDR(I)
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(Fig 5)
Mass spectrum of the peptide digest from sample #5
obtained using the ProGest Validation kit.

756 .304

834 .451

842.51

927.497

1097.55

1163.62

1283.71

1305.71

1419.69

1439.82

1479 .8

1485.88

1536.76

1567.75

1589.75

1639.95

1687.87

1734.73

1791.67

1880.92

1907.93

2045 .03

2211.1

2278.03

2487.67

2780.37

2807.44

3323.78

Search Results

1. 12/28 matches (42%). 69293.9 Da, pI = 5.82. Acc. # P02769. BOVIN.
SERUM ALBUMIN PRECURSOR.

m/z MH+ Delta
submitted matched ppm start end Peptide Sequence
927.4973 927.4940 3.6195 161 167 (K)YLYEIAR(R)
1163.6161 1163.6312 -12.9893 66 75 (K)LVNELTEFAK(T)
1283.7136 1283.7112 1.8724 361 371 (R)HPEYAVSVLLR(L)
1305.7061 1305.7167 -8.1149 402 412 (K)HLVDEPQNLIK(Q)
1439.8190 1439.8123 4.6690 360 371 (R)RHPEYAVSVLLR(L)
1479.8015 1479.7960 3.7041 421 433 (K)LGEYGFQNALIVR(Y)
1567.7508 1567.7433 4.7811 347 359 (K)DAFLGSFLYEYSR(R)
1639.9482 1639.9383 6.0576 437 451 (R)KVPQVSTPTLVEVSR(S)
1687.8698 1687.7862 49.5094 118 130 (K)QEPERNECFLSHK(D)
1791.6697 1791.7100 -22.5196 267 280 (K)ECCHGDLLECADDR(A)
2045.0344 2045.0285 2.8714 168 183 (R)RHPYFYAPELLYYANK(Y)
2278.0305 2278.2310 -87.9861 1 19 (-)MKWVTFISLLLLFSSAYSR(G) 1Met-ox
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